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1. OVERVIEW 
 
1.1 INTRODUCTION 
 

Smart GSM is an application used for total management of a mobile phone using a 
Pocket PC device.  It enables the user to manage the phonebook, SMS messages, creating 
and editing operator logos, group graphics, picture SMS messages and working with 
ringtones. 

 
It is possible to run smart GSM on any Pocket PC with ARM, MIPS or SH3 

processors. It supports a large variety of phones by connection to these devices using the 
infrared port, Bluetooth or cable. 
 
1.2 INSTALLATION 
 

Smart GSM is distributed as a self-extracting EXE file. Simply download the EXE 
file to your local PC and run the executable to install the application to your Pocket PC 
device.  During this installation, the setup instructions will appear in a dialog window. After 
successful installation, an icon will be created in Start menu -> Programs from where you 
can run the application. 

 
We recommend having at least 2MB memory space for installation and 2MB of 

memory for running the application on your Pocket PC. 
 
1.3 REGISTRATION 
 

Smart GSM is licensed as Shareware that can only be used fully for 15 days without 
registration. After expiration of this trial period it is necessary to register the application for 
further use. You can do so by purchasing the application license online at 
http://www.smartsoftworks.com/purchase after which, you will receive a registration 
application to download and run. During the registration process, follow the instructions 
displayed in the dialog window. After running this application on your PC, smart GSM will 
automatically be registered and it is possible to use it in full without any restrictions.  
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2. USER INTERFACE 
 

The User Interface is designed to enable a simple, convenient and fast manipulation 
of data, graphics and information stored on your mobile phone. The title informing you of 
the current action selected, is located at the top center of the screen. A menu enabling 
a switch to another option appears simply by tapping on this title.  The menu contains the 
following options: 
 

• Phonebook – working with the telephone book 
• Messages  - working with SMS messages 
• Logos – working with graphics 
• Ringtones – working with ringtones 
• Dialer – working with incoming and outgoing calls 
• Phones – working with profiles for multiple phones management 

 
In some screens it is possible to bring out another menu designed for that specific 

screen by clicking on a blue banner on the top of the screen. 
 
In the upper left corner you will find information about the signal strength, and in the 

upper right, battery power remaining of the currently connected phone. This information will 
not be available if no phone is connected. 

 
At the bottom left of the screen you will find another banner informing you about the 

type of phone connected, and on the right, about the chosen profile. It is important to 
remember that it is possible to work while the phone is not connected, and to synchronize all 
the changes later on when it is convenient to connect your mobile phone. By tapping on the 
chosen profile information, a menu containing a list of all the possible profiles will open. 
A checkmark indicates the phone profile currently connected. 
 
Note: Menu Phonebook and Messages are not active and therefore it is not possible to 
choose them as long as no phone was connected and no profile for this phone exists. 
 

At the bottom of the screen is the tool bar containing options for quick access to some 
functions of which the Phone option is identical for every screen.  This contains the 
following actions: 
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• Connect – connects the phone 
• Connect phone – create a connection with the currently selected phone, using 

the previous connection type for this phone. For a Bluetooth connection, this 
function will make the application connects to the phone faster by directly 
connecting to the phone without searching for the phone availability. 

• Disconnect – ends the connection with the phone 
• Phone info – shows the information about currently connected phone 
• Connection – connection settings 
• Preferences – program settings 
 

2.1 CONNECTION 
 
This screen is used for the setting the method of the connection: 
 

• General – this type is used for most phones. It 
works with phones that have a built-in hardware 
modem using the infrared port or serial 
communication and it is necessary to choose 
a COM port number that will communicate with 
the equipment. For connecting a phone using 
Bluetooth, it is necessary to set to the serial 
connection setting and then selecting a virtual 
COM port. This setting can be found in the 
manual for the Pocket PC device. 

 
• Nokia – this connection type is used for connection only with Nokia phones 

using either infrared port or cable. Infrared/Bluetooth connection works with 
the newer models, Serial IR is designed for connection of models 6110/… and 
Serial Cable communicates with Nokia phone connected to the Pocket PC via 
a cable. 

• Ericsson – connection can be carried out through Bluetooth and Infrared ports 
and it is used for newer Ericsson phones 

• Siemens – connection can be carried out only through Bluetooth/Infrared port 
and it is used for newer Siemens phones. 

 
Note: Before connecting the new phone make sure that settings match with the connecting 
phone. For example if you have a Nokia phone that supports more phone numbers for one 
contact, always choose Nokia in Phone model, otherwise if you choose General the program 
will read only one number from the contact. 
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2.2 PREFERENCES 
 
This screen allows you to change some application settings: 
 

• Name view – determines the method of showing 
and sorting of contacts in the phone book and 
SMS messages. There are two choices: First, 
Last or Last, First 

• SMS Sound – option to choose own sound for 
the incoming SMS. Support for WAV files. 

• Call Sound – option to choose own sound for the 
incoming call. Support for WAV files. 

• Request delivery reports – entry is used 
should confirmation of delivery of the SMS 
message be required. 

• Save sent messages to sent folder – if this entry is ticked, all sent messages 
would be saved to folder smart GSM -> Sent  

• Delete contacts also from Outlook – determines whether the contact that is 
being deleted from the application will automatically be deleted from Pocket 
Outlook. This is important only when synchronization of the phonebook and 
Pocket Outlook is on 

• Show deleted items – if this box is ticked, the application will also show the 
entries marked to be deleted. It is possible to restore these entries as long as there 
is no synchronization between the Pocket PC and the phone, otherwise it will be 
lost forever. This is applicable for the phone book and SMS messages. 

• Erase messages in phone – mark this entry only if you wish to automatically 
delete messages from the phone and save them in smart GSM during 
synchronization of received SMS messages, or when receiving a new SMS. This 
entry is convenient for owners of phones with a small memory capacity of SMS 
messages. 

 
2.3 CONNECTING AND DISCONNECTING PHONE 
 

Before the actual connection it is recommended to check the connection type of the 
phone, since the phonebook can be synchronized only with the connection type that was 
used to connect the phone for the first time. The reason is that some types of phones can be 
connected using several connection types but it is not possible to fully work with the 
phonebook in all of them. For example, using the General connection type it is not possible 
to gain more entries in one contact, whereas this is possible using another connection. 
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Connecting the phone is also possible by tapping on the  icon located on nearly 

every screen, whereas by tapping on the  icon will disconnect the phone. The  icon can 

be used for quick connection to the phone which profile is currently selected.  Further 
information regarding to this connection are available in the PHONE-CONNECT PHONE 
section. 

 
After selecting of the type of phone connection, a 

window will appear, informing about the selection made.  If, 
during this process, a red cross appears anywhere on the 
screen without user’s intervention, a wrong connection type 
was probably selected and it needs to be changed. 

 
After successful initial communication, smart GSM 

will check whether the phone was previously connected and 
saved in the database of connected phones or not. If the phone 
was connected for the first time, a prompt would appear, 
asking the user to enter the name of this profile being created 
– every phone in the database has its own phonebook and 

SMS messages, as well as other customizable settings.  After confirmation of the profile 
created, three new screens will appear (Basic settings, Name interpretation and Outlook 
settings); this is where the user is able to confirm the settings for phonebook 
synchronization. These settings are described in the Phones section and it is recommended 
to read this Section first. 
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3. PHONEBOOK 
 

The section is used for convenient and fast work with 
the phonebook. Below the upper blue bar are tabs used for 
quick searching by initial letter. By double tapping on a 
required tab, will let you go to the first contact starting with 
the following alphabetical letter. 

 

If an icon appears before the name in the list of 

contacts, it indicates that the contact is stored on the SIM 

card, whereas the  icon informs you that the contact is 

stored in the phone memory.  By tapping on the center of the 
upper blue bar, you would also see a menu with a choice of memory options 
(All/Phone/SIM) indicating on what type of memory the contacts are stored on the phone. 

  
Use the scrollbar on the right to go through the list of contacts.  To select several 

contacts, press the stylus anywhere in the phonebook and then move it up or down 
depending on the contacts you want to select. This can be done even with contacts not 
visible on the current screen.  The page will scroll either up or down until you remove the 
stylus.   

 
If a contact is highlighted in red, it indicates that a change was made (contact is new 

or was modified after last the synchronization), and it is necessary to synchronize with your 
phone. If the contact is also stroked through, it indicates that it was selected for deletion and 
will be permanently deleted from smart GSM as well as from the phone.  This action can be 
undone by tap and holding and selecting undelete. 

 
For every update of contacts in the Pocket Outlook, the update will reflect in smart 

GSM and every updated contact will have its name highlighted with green color. Updated 
contacts in smart GSM will not be automatically re-ordered in alphabetical order. The user 
should manually re-order the updated contacts using the  icon. After the manual re-order, 
the updated contacts (the ones that have been highlighted with green color) will have the 
appropriate color (red for deleted contacts or black).  This process applies only to the 
phonebook that is synchronized with the Pocket Outlook. 

For the phonebook that is synchronized with the Pocket Outlook, any updates in the 
Pocket Outlook (while the smart GSM is not running) will trigger the appearance of the  
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icon (on the upper-right corner of the screen).  This icon is an indicator for the current status 
of background synchronization of the updated contacts.  The background synchronization 
process will highlight the updated contacts in smart GSM with green color, and the re-order 
icon will appear. 
 
3.1 OPENING CONTACTS 
 

By tapping on the contact or selecting the Open function from the menu, a new 
screen with the contact details will appear.  Information about the contact, such as a caller 
group, phone numbers, notes and addresses are displayed. 

 
3.2 CREATING AND EDITING CONTACTS 
 

After selecting New or Edit, by tap and holding on a 
contact, a new screen for modifying the contact – its name, 
caller group, phone numbers or other text entries, will 
appear.  It is only possible to add or modify entries if your 
phone supports it.  Phones that can only display one type of 
phone number/text entry have this entry displayed in the 
phonebook, even if it doesn’t contain any information.  If 
you want to add any new information to the entry you need 
to select the required context menu by holding down the 
stylus.  The following options then appears:  
 
• Add – adds a new entry to the contact – phone 

number or text 
• Delete – deletes the marked entry 
• Change type – allows to change the type of the entry in case the phone supports 

several entries in one contact 
• Set as default – sets the chosen entry as default. Applicable only for entries with 

the phone number 
 
It is possible to select the storage memory where a new contact should be created by 
selecting the appropriate memory from the blue bar before creating this new contact. If the 
All contacts option is selected, a new contact will be created in the phone memory by 
default.  When the phone book is synchronized with Pocket Outlook, all the changes in this 
window will automatically appear in Pocket Outlook. 
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3.3 IMPORTING CONTACTS 
 

This function is used for importing contacts from Pocket Outlook to smart GSM.  
By selecting File -> Import, a new display will appear listing all contacts in Pocket Outlook.  
Simply tap on the box located to the left of the contact to select. To undo, tap again.  A 
selected contact is distinguished with a red tick.  You can select multiple contacts to import 
at the same time by tapping all the boxes before the names.  Imported contacts will be saved 
to the memory as shown in the upper blue bar.  If you need to select all contacts, simply hold 
the stylus for about 2 seconds on one place and a menu with the entry Select All will appear.  
Contacts will be saved in the phone memory if you selected All contacts.  Contacts will not 
be displayed in this list if they are already listed in the phonebook when synchronizing with 
Pocket Outlook. 

All contacts from the Pocket Outlook will be displayed in this list only if there is no 
automatic synchronization between the phonebook and the Pocket Outlook. Every contact 
that has been previously imported will be highlighted with red color and it will be updated 
instead of being duplicated. 
 
3.4 SYNCHRONIZING CONTACTS 
 

All changes made in the phonebook on either side since the last synchronization is 
exchanged by synchronizing between the mobile phone and your Pocket PC device.  This 
means that changes made on your Pocket PC will also appear on the phone and vice versa.  
After synchronization, information in both phonebooks will be identical. 
 

Should it appear that a contact was changed on both sides (on the Pocket PC and on 
the phone), a screen with the conflict contact will appear and the user can see detailed 
information about the contact and choose the direction of synchronization: 
  

• From Pocket PC to phone – contact in the phone will be replaced with the 
contact from Pocket PC. 

• From phone to Pocket PC – contact in Pocket PC will be replaced with the 
contact from the phone. 

• Combine items – after selecting this entry both contacts will be saved. This entry 
will only be shown, should a contact be erased on either side. 

 
Note: After unsuccessful synchronization, a dialog screen would appear, informing you about 
any contacts that could not be synchronized.   This can occur should the text of the name, or 
the phone number be too long. 
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3.5 RESTORING CONTACTS DELETED IN PHONE 
 

For this function we use the entry Mark as new in the menu.  This is helpful in a 
situation when you accidentally erase a contact directly from the phone where the contact 
cannot be restored.  If you select this function, you mark the selected contact as new in 
smart GSM.  This contact will lose any linking between the original contacts in the phone 
and will be created as new during the next synchronization. 
 
3.6 MENU 
 
3.6.1 FILE 
 

• New – creates a new contact 
• Send SMS – creates a new SMS message for selected recipient in the book 
• Import – this function is used for importing contacts from Pocket Outlook to 

smart GSM 
• About – shows the window with information about the program and the author 
• Exit – ends the application and in case there are some changes that were made 

but not saved it will show a dialog window asking if the changes need to be 
changed 

 
3.6.2 EDIT 
 

• Mark as new – restores erased contact in the phone. 
• Cut – moves selected contacts to the clipboard. 
• Copy – copies selected contacts to the clipboard. 
• Paste – inserts contacts from the clipboard to the phonebook.  Contacts will be 

saved in the phone memory if the All contacts option is selected.  
• Delete – marks selected contacts as deleted. 
• Undelete – restores selected contacts that were marked as deleted. 
• Select all – will select all the contacts in the list. 
• Reload – reloads a list of contacts from database. 
• Find – selecting this function will open an edit box for searching any contacts. 

As you tap in letters, the contact list automatically renews, taking into 
consideration initial letters of the first and the last name. 
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3.6.3 SYNC 
 

This menu is used for synchronization of the phonebook between the phone and the 
Pocket PC device.  The menu changes, depending on the number of SIM cards that exist in 
the selected profile.  (Use of more SIM cards is described in Phones)  If you wish to 
synchronize contacts from both the phone memory and SIM card, select the entry All.  If 
there is more SIM cards in the profile, it is necessary, after opening a new menu, to 
determine which card should be synchronized with the phonebook.  For synchronization of 
only one memory (SIM card or phone memory), select this memory from the menu. 

 
Note: Contacts can only be synchronized with the phone using the connection type that was 
used to connect the phone for the first. 
 
3.6.4 TOOLBAR IMAGES 
 

         

New Open Edit Send SMS Import Cut Copy Paste Delete 
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4. MESSAGES 
 

Selecting this screen provides you with a convenient 
and quick manipulation and storing of your SMS messages, 
as well as sending and receiving.  All SMS messages are 
stored in subfolders for better orientation.  There are two 
main folders to choose from (Phone or smart GSM), 
depending on whether SMS messages are synchronized with 
the phone, or stored in the application only.  By clicking on 
the upper blue bar, you can easily move within these folders. 
Beside the name of the folder you can also see one or two 
numbers.  These numbers indicates the total number of SMS 
messages in the folder. Should two numbers appear the first 

would indicate unread messages, and the second the total number of messages in the folder. 
 

A list of all SMS messages in the selected folder appears and you are able to work with 
the messages the same way as you would with the phonebook.  The icon to the left of the 
SMS informs you about the type of message: 
 

 Received text SMS 

 Sent SMS or ready to be sent 

 Received picture SMS 

 Sent picture SMS or ready to be sent 

 Received information about delivery of SMS

 
By holding down the stylus anywhere on the screen, opens a context menu with further 

options.  Particular functions are described below. 
 
To select a SMS message, tap and hold the stylus on the scrollbar and then move up or 

down, depending on the SMS that you want to select. 
 
If the SMS message is marked in red, it indicates that there was a change, (SMS is new 

or was modified after last synchronization) and it is necessary to synchronize with the phone.  
If the SMS message is also stroked through, the message was selected for deletion and it will 
be permanently deleted from smart GSM as well as from the phone.  Smart GSM 
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automatically links chained SMS messages (long SMS support) into one and in the case of 
any message being missing; it will be marked brown in the folder. 
 
4.1 OPENING CONTACTS 
 

After tapping on a SMS message or selecting the Open function from the menu, a 
screen with a detailed description of the message appears.  It contains all the details listing 
the sender or recipient, particular times, complete contents of the message and in the case of 
a picture message, also the picture.  Should there be incomplete chained SMS messages, the 
information about the missing message and the text will be highlighted in a brown color.  
When an unread message is opened, it will be marked as read, and after synchronization it 
will also be marked as read in the phone. 

There are three icons available on this screen for the quick navigation of reading 
SMS messages, they are:  for reading the previous message,  for reading the next 
message, and  for deleting the currently displayed message. 
 
4.2 CREATING AND EDITING SMS MESSAGES 
 

After selecting the option for creating and editing 
SMS messages, a new screen would appear where the 
message can be edited and also be sent immediately.  The 
Recipients of the SMS message is displayed in the upper part 
of the screen.  It is possible to enter a number directly to this 
edit box. When tapping on any other area of the screen, the 
number would automatically be changed to the name of the 
recipient, should this name be listed in the phonebook.  
Alternatively, tap on the arrow to select a recipient from the 
list of recipients from the last sent messages, or tap the icon 

 to select a recipient from the phone book.  Select the 

recipient by placing a tick in the checkbox before the name, and then tap the green 
checkmark at the bottom left of the screen.   In the list of contacts you have the option to 
select a name from either the phone, or from Pocket Outlook.  This is done by tapping on the 
blue bar and selecting the applicable database. 

 
Two numbers are shown on the upper right side of the text field, indicating the 

amount of characters still available until the maximum is reached and the second indicates 
the amount of messages that will be sent.  In the case of a picture message this information 
could be highlighted in red.  This would indicate that the limit of the permitted characters 
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was exceeded and for the successful delivery of the message, it is necessary to delete some 
characters from this message. 

Every outgoing SMS message can be set to be sent using the Unicode character set.  
An SMS message that is sent using the Unicode character set may contain special characters, 
such as accented characters, but this type of message will have a more limited number of 
characters compared with the normal message since Unicode characters consume more bytes 
of data in the message.  A Unicode SMS message has a maximum number of characters at 
half the normal message. 

The Flash SMS option may be used for sending an SMS message which will be 
displayed directly on the recipient phone’s screen.  The recipient phone that will receive this 
type of SMS message should support the Flash SMS feature. 
 
4.2.1 SMS MENU 
 

• Insert picture – adds a picture to the SMS message and that is either a picture 
sketched in a logo screen (From logo screen) or directly from the file (From 
file). 

• Remove picture – removes picture from SMS. 
• Send now – when the message is complete and ready to be sent, it will be sent 

immediately by selecting this entry. 
• Save to draft – stores the message as a concept to the folder smart GSM -> 

Draft. 
• Save to outbox – stores the message as ready to be sent to the folder smart GSM 

-> Outbox, from where it can be sent later. 
 
4.3 SYNCHRONIZING SMS MESSAGES 
 

Synchronization between the phone and the Pocket PC is used for the exchange of all 
the modifications made in SMS messages on either side since the last synchronization, which 
means that the changes in Pocket PC will be displayed on the telephone and vice versa.  
Only the messages in the folder Phone folders are synchronized. 

 
During the synchronization a screen containing a conflict message could appear.  

This happens when a message was modified on both sides, on the Pocket PC as well as on 
the phone. You then have the option to select which direction you want to synchronize the 
message: 
 

• From Pocket PC to phone – SMS message in the phone will be replaced with 
the message from Pocket PC. 
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• From phone to Pocket PC – SMS message in Pocket PC will be replaced with 
the message from the phone. 

• Combine items – after selecting this entry both messages will be saved. 
 

SMS messages can be synchronized with any connection type your phone supports. 
However, if the connection type does not agree with the type used for the last 
synchronization of messages, a dialog box with this information will appear and the 
application will have to read the messages again.  You would then lose all the modifications 
that were made in smart GSM in the Phone folder since the last modification. 
 
4.4 RESTORING SMS MESSAGES DELETED IN PHONE 
 

To restore, select Mark as new from the Edit menu.  It is a helpful tool, should you 
accidentally have erased a SMS message directly from the phone where it cannot be 
restored.  If you select this function, you mark the selected contact as new in smart GSM.  
This message will lose any linking between the original messages in the phone and will be 
created as new during the next synchronization. 

 
4.5 MANAGING SMS FOLDERS 
 

All SMS messages are hierarchically filled into folders, whereas these folders are 
then filed into two main folders: 
 

• Phone - SMS messages stored in the phone 
• smart GSM - SMS messages stored in application 

 
SMS messages in the Phone folder are fully synchronized with the phone, meaning 

that all the changes in this folder will appear on the phone after synchronization.  Similarly, 
changes on the phone will also appear in this main folder.  Messages stored in the smart 
GSM folder are only used as an archive for messages. 

 
After tapping on one of the folders from the menu, (Phone or smart GSM), a 

dropdown box listing all sub-folders appears.  Below are the basic folders but may differ if 
own folders were created on the phone: 
 

• Inbox – this folder can only contain received SMS messages and cannot be 
deleted. 

• Outbox – this folder can only contain sent messages or messages set to be sent 
and cannot be deleted. 
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• Inbox/Outbox – folder contains messages sent or received or messages set to be 
sent and cannot be deleted. 

• Templates – this contains the standard SMS messages hard-coded on the phone.  
It could contain either sent messages or messages set to be sent and cannot be 
deleted. 

• User folder – this folder can contain all different types of messages and was 
created by the user; therefore it can be deleted or modified. 

• Empty – internal folder of the application, it includes the Outbox (messages set 
to be sent), Sent (sent SMS messages) and Draft (concepts of SMS messages) in 
the smart GSM main folder and cannot be deleted. 

 
Only newer models of Nokia phones supports the creating, editing or deleting of 

folders in the main Phone folder.  If your phone does not support this, the application does 
not allow any changes.  In the smart GSM folder, you are able to make any changes, 
however the folders Inbox, Outbox, Draft and Sent cannot be modified at all and you are 
not allowed to copy any SMS messages to the last three. 
 
4.5.1 FOLDER MENU 
 

• New folder – creates a new folder. 
• Delete – marks the folder as deleted.  After synchronization it will be 

permanently deleted, together with all the messages it contains. 
• Undelete – restores the folder that was marked as deleted. 
• Rename – if the program allows this function, it lets the user to change the name 

of the folder. 
 
4.6 MENU 
 
4.6.1 FILE 
 

• New SMS – creates new SMS in selected folder. 
• About – shows information about the program and the author. 
• Exit – ends the application.  Should some changes that were made but not 

saved, a prompt would appear asking if the changes need to be saved. 
 
4.6.2 EDIT 
 

• Phone folders – manages the folders in the phone. 
• smart GSM folders – manages the folders in the application. 
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• Mark as new – restores deleted SMS messages in the phone. 
• Cut – moves selected SMS messages to the clipboard. 
• Copy – copies selected SMS messages to the clipboard. 
• Paste – inserts SMS messages from the clipboard to the folder. 
• Delete - marks selected SMS messages as deleted. 
• Undelete - restores selected SMS messages that were marked as deleted. 
• Select all - selects all the SMS messages in the list. 
 

4.6.3 SYNC 
 

This menu is used for synchronization of SMS messages between the phone and the 
Pocket PC device, so all the changes made on either side after the last synchronization will 
appear on both appliances. 
 

• All folders – synchronizes all subfolders in the Phone folder. 
• Actual folder – synchronizes messages only in a selected subfolder.  
• Send from outbox – sends the SMS messages that are ready to be sent – they are 

located in the smart GSM -> Outbox folder. 
• Purge smart GSM folders – erases all the messages from smart GSM folder 

that were marked to be deleted. 
 
4.6.4 TOOLBAR IMAGES 
 

          

New Open Edit Reply Forward Send from 
Outbox 

Cut Copy Paste Delete
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5. LOGOS 
 

By select this screen the user have some tools 
available to create new operator logos, group logos, startup 
logos as well as logos used to create picture SMS messages.  
You can send or receive these logos directly through infrared 
port or send them through SMS messages. 

 
The User Interface contains a blue bar and by tapping 

on the bar, a menu would appear from which a selection can 
be made, which logo you wish to modify: 
 

  • Operator logo 
  • Caller group logo 
  • Startup logo 
  • Picture message 

 
5.1 LOGO EDITING 
 

In the drawing field you can design your own pictures by using certain tools.  You 
can choose it directly from the Tools menu or by tapping on any of the icons as shown 
below: 

 

 Pencil 

 Eraser 

 Line 

 Rectangle 

 Ellipse 

 Fill 

 Selection and movement of the block

 Moving within a picture 

 
The two buttons next to the icons - and +, are used for zooming in or out.  It also 

indicates enlargement magnification. 
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On the upper left side of the screen is another box showing the actual logo.  If you tap 
and hold your stylus on this box, you would be able to drag it anywhere on the screen and 
place it on any other convenient position. 

 
Moving within the picture can be done in two ways, either with the cursor keyboard 

on your Pocket PC, or by selecting the  tool and then directly move the drawing in any 

direction, using your stylus. 
 
5.2 DOWNLOADING LOGO 
 

After selecting the Download icon, the logotype currently set in the blue bar will be 
downloaded from the phone.  If a caller group logo is set, it is necessary to determine from 
the menu which logo needs to be downloaded. 
 
5.3 UPLOADING LOGO 
 

The Upload function is used for writing any edited logo directly into the phone using 
the infrared port.  If the operator logo is set, it is necessary to determine which operator this 
logo will be replacing.  You can select the operator from the list of countries, or by direct 
insertion of the operator code.  If the caller group logo is set, it is necessary to determine 
which caller group are supposed to be presented on the phone. 
 
5.4 SENDING LOGO VIA SMS 
 

It is possible to send operator, caller group or picture message logos to recipients 
through a mobile network by using short SMS messages and is done by selecting the Send 
via SMS function.  Should an operator logo be sent, it would be necessary to determine the 
operator, in the same way as in uploading the operator logo into the phone.  Sending a logo 
as a SMS message is similar to the sending of the text SMS message in as described in the 
Messages section. 

 
5.5 RESTORING ORIGINAL LOGO 
 

If you wish to restore the original operator logo, and in doing so, cancel the logo 
currently on your mobile phone, you can do so by selecting the Restore option from the 
menu.  This option is currently only available for operator logos.  After successful operation 
you should see the original operator logo or text on the display of the phone.  Some phones 
needs to be switched off and then back on for this change to take effect.  
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5.6 MENU 
 
5.6.1 FILE 
 

• New – creates an empty logo.  smart GSM distinguishes several size formats and 
after tapping this option, another menu with all the available pictures size formats 
will open.  

• Open – reads the saved logo from the file.  Supported formats are SML, BMP, 
NOL, NGG a NLM 

• Save – stores the currently edited logo directly to file.  If the logo was not named 
and no storage file was selected, a prompt to make these selections will appear. 

• Save as – function is used for storing currently edited logo under a different 
name. Supporting formats are SML and BMP 

• About - shows the window with information about the program and the author. 
• Exit - ends the application.  Should some changes that were made but not saved, 

a prompt would appear asking if the changes need to be saved. 
 
5.6.2 EDIT 
 

• Undo – returns to the last performed operation.  
• Cut – moves a selected block to the clipboard. 
• Copy – copies a selected block to the clipboard. 
• Paste – inserts a block from the clipboard to the upper left corner of the logo.  

From here it can be moved with a stylus. 
• Delete – deletes a selected block. 
• Hide selection – hides the actual selected block. 
• Grid – turns the grid on or off in the logo editing box. 
• Preview – shows or hides the window with the preview. 

 
5.6.3 TOOLS 
 

In this menu you can choose one of the tools described above. You can also find the 
Invert selection option that inverts a selected part of a logo. 
 
5.6.4 SYNC 
 

• Upload – uploads an edited logo directly to the phone through an infrared port. 
• Download – downloads a logo from the phone through an infrared port. 
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• Send via SMS – allows a user to send a logo through a mobile network as SMS 
message 

• Restore – cancels a current logo. 
 
5.6.5 TOOLBAR IMAGES 
 

          

New Open Save Download Upload Send via SMS Cut Copy Paste Delete 
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6. RINGTONES 
 

This section is used for the creation of simple ringtones and then sending it to the 
mobile phone via the infrared port or SMS message through a mobile network. Polyphonic 
ringing tones are supported by smartGSM, they can only be played-back or uploaded to the 
connected phone but not edited.  Playing polyphonic ringing tones in smartGSM requires the 
‘Instruments for playback polyphonic MIDI files’ feature that is a part of the application 
installation process. 
 
6.1 RINGTONE EDITING 
 

The center of the screen is dominated by a stave in 
which you can move and select note blocks to create a 
melody.  Moving can be also done with the left, right, up or 
down cursor keys of your Pocket PC or by using your stylus, 
to change the length of the selected note or notes. 

 
Under the stave on the left side, various notes are 

available to determine the length of an inserted note.  Tapping 
on any of these notes, would highlighted it in blue.  A period 
determines an increase of half a step up on the selected note. 
Next to the period is a dash that is used to insert a selected 

pause length into the melody. Individual notes are inserted using the keyboard by tapping on 
the specific key.  On the right side the following buttons are located: 
 

 Plays the tune from the cursor to the end 

 Deletes selected note under the cursor or selected block 

 Deletes a note before the cursor or selected block of notes 

 Shows the window for setting a name of the melody and playing speed 

 Moves the cursor one note to the left 

 Moves the cursor one note to the right 

 Moves the cursor to the beginning of the melody 

 Moves the cursor to the end of the melody 

 Rises selected notes one half-step up 

 Lowers selected notes one half-step down 
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6.2 UPLOADING RINGTONE 
 

The current edited melody is sent directly to the mobile phone via the infrared port 
when this option is selected. 

  
6.3 SENDING RINGTONE VIA SMS 
 

The ringtone could be sent to any specified recipient through the mobile network as a 
short SMS message when the Send via SMS option is selected.  It is very similar to the 
sending of a short text message as explained in the Messages section.  

 
Note: smart GSM can only send monophonic ringing tones through the SMS. 
 
6.4 MENU 
 
6.4.1 FILE 
 

• New – creates a new melody. 
• Open – reads an already written melody from the file.  Supported formats are 

SMR, MID and TXT. 
• Save – stores currently edited melody directly to file.  If no name was given to 

the melody and no path for storing was selected, a prompt would appear to make 
this selection. 

• Save as – function is used for storing the melody currently being edited under a 
different name.  Supported format is SMR 

• About – shows the window with information about the application and the 
author. 

• Exit – ends the application.  Should some changes that were made but not saved, 
a prompt would appear asking if the changes need to be saved. 

 
6.4.2 EDIT 
 

• Cut – moves a selected block to the clipboard. 
• Copy – copies a selected block to the clipboard. 
• Paste – inserts a block of notes from the clipboard to the actual position of the 

cursor. 
• Delete – deletes a selected block of notes. 
• Octave up – raises selected notes one octave up. 
• Octave down – lowers selected notes one octave down. 



27 
 

 

• Note up – rises selected notes one half step up. 
• Note down – lowers selected notes one half-step down. 
• Select all – selects all the notes in melody. 
 

6.4.3 SYNC 
 

• Upload – stores the ringtone directly to the phone through the infrared port. 
• Send via SMS – allows the user to send a melody through a mobile network as a 

short SMS message. 
 
6.4.4 TOOLBAR IMAGES 
 

         

New Open Save Download Send via SMS Cut Copy Paste Delete 
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7. DIALER 
 

Dialer is a feature of smartGSM for phone call management, incoming and outgoing 
calls. Owners of a Bluetooth-enabled mobile phone will get a benefit of this feature. 

 
7.1 SCREEN 

 
At the top area of the screen, there is a display area 

that will display any information regarding to the current 
status of the dialer, such as incoming or outgoing calls, typed 
numbers for an outgoing call. Under the display area, there 
are buttons that have similar function to a mobile phone keys.  
These buttons have intuitive design for accessing the numbers 

(0..9), +, *, #, p (pause), and w (wait).  Use the  button 

to delete the last entered digit. 
 

7.2 ANSWERING AND MAKING CALLS 
 

 The  key is used to make an outgoing call to the entered numbers (displayed on 

the display area) and to answer an incoming call as well, while the  key is used to end 

the current call. 
 There is an alternative way of making an outgoing call, which is by selecting a 
number from the phonebook, or from the list of dialled/received calls. 
 
 
7.3 LIST OF THE LAST DIALLED AND RECEIVED CALLS 
 

The list of the last dialled calls can be accessed from the ‘Dialled numbers’ menu 
item, under the ‘Calls’ menu, and the list of the last received calls can be accessed from the 
‘Received calls’ menu item, under the same ‘Calls’ menu.  Every item in the list of dialled 
calls may contain the contact name and the types (mobile, home, fax, or any other available 
types) of the number if the number matches with the one in the phonebook. 
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For every item in the list of dialled or received calls, tap-and-hold on the item to bring its 
context menu up. This context menu has two menu items: 
 

• Call number – call the selected number 
• Delete numbers – delete the selected number from the list 
 

7.3.1 TOOLBAR IMAGES 
 

   

Dial number Close window Delete numbers

 
7.4 MENU 
 
7.4.1 FILE 
 

• About – display a window containing the information about the smartGSM 
application and its author 

• Exit – end/terminate the smartGSM application.  smartGSM will ask for a 
confirmation regarding to the unsaved changes when the application is about to 
be terminated, whether the changes are going to be saved or not. 

 
7.4.2 CALLS 
 

• Dialled numbers – display the list of the last dialled numbers 
• Received numbers – display the list of the last dialled numbers 
• Phonebook – open the phonebook and directly dial a number from the 

phonebook 
 

7.4.3 TOOLBAR IMAGES 
 

   

Dialled numbers Received numbers Phonebook 
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8. PHONES 
 

Smart GSM allows working with several phones at the same time.  Each phones has 
their own phonebook, SMS messages and other settings as described below.  This means that 
changes made on one phone via smart GSM does not affect any other phone. 

 
By selecting the Phones menu, you are able to view a list of all phones registered 

with smart GSM.  Here you can amend any phone’s settings.  The first column shows the 
profile name, the second indicates the phone type and third entry lists the amount of SIM 
cards used by the phone.  By tapping and holding your stylus down on a selected phone, a 
sub-menu will open with further options. 
 
8.1 BASIC SETTINGS 
 

In this screen you can set some basic information, 
such as telephone profile name in entry Phone name, set the 
number of the SMS center for sending short SMS messages in 
entry SMS center. If you accidentally changed this number 
and you don’t remember the original, simply delete the 
number and program will read the original again after the 
phone is connected. 

 
By selecting Phonebook memories you can view a 

list of all the available memories available to store contacts.  
Two basic memories available, phone memory and a SIM 

card. 
Smart GSM is capable of storing the contents of several SIM cards used by one 

phone. This function is helpful should you use multiple SIM cards in one phone, leading to 
several phonebooks, and you require that the contacts stored on all these cards also be 
present in smart GSM.  Changes made to one SIM card will not affect another SIM card and 
changes can be synchronized without any complications. 

 
By tapping on the selected memory, a new screen opens with options to set the 

attributes of the selected memory: 
 

• Name – sets a name for the memory, e.g. to simplify the diversity of SIM cards. 
• Sync with outlook – this setting determines whether the contacts from the 

selected memory needs to be synchronized directly with the contacts in Pocket 
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Outlook.  This means that smart GSM does not store the contacts, and changes 
can be made in both applications, whereas these changes will always be displayed 
on both applications and after synchronization also on the phone.  It is good to 
keep in mind that not all the contacts listed in Pocket Outlook will also be on the 
phone, only those that are created or are imported to smart GSM, or to the phone 
within the selected memory. This function can only be set if the phonebook is 
empty. 

• Ignore acc chars – with this setting you can determine whether adequate 
characters or symbols will replace characters with punctuation marks without any 
punctuation during the synchronization sequence.  It is useful in case your phone 
does not support characters with punctuation marks, but you still want to have 
these saved in smart GSM or Pocket Outlook.  All symbols with punctuation 
marks are replaced by the adequate symbols without punctuation from smart 
GSM to the phone if this function is selected when synchronizing. 

 
By holding the stylus down you can open a context menu and choose from the 

following entries: 
 

• Add SIM card – allows to add a new SIM card. 
• Edit – opens a window with specific settings for the selected memory. 
• Delete – deletes a selected memory from smart GSM, together with all its 

contacts.  smart GSM allows the deletion of the SIM card memory only, and at 
least one SIM card has to remain after the deletion. 

 
8.2 NAME INTERPRETATION 
 

This option allows you to set the way names are 
interpreted and displayed in the contact list of your phone.  
smart GSM will divide and create entries, as some phone 
models does not have the function to separate between first 
and last name.  If you select First, Last, the first word of the 
name will be interpreted as the first name and the second 
word as the surname and vice versa by smart GSM. This 
function can only be set if the phone book is empty. 
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8.3 OUTLOOK SETTINGS 
 

This option allows you to set the link between smart 
GSM and Pocket Outlook. Individual entries determine the 
entry of the contacts in Pocket Outlook that will be 
synchronized with the actual type of phone number or text.  
On the left is the type of entry stored on the mobile phone and 
on the right, the options available when synchronizing.  This 
setting is also used when importing contacts, to specify under 
which classification smart GSM will store the contact. 
 
8.4 MENU 
 
8.4.1 FILE 
 

• Import – this function is used for importing the entire profile of the phone from 
file.  This action cannot be executed if the given phone already exists in smart 
GSM, and the current profile needs to be deleted from smart GSM before the 
new profile can be imported.  If the imported profile has contacts synchronized 
with Pocket Outlook, they will be recreated with all the entries, even the ones that 
are not listed in smart GSM (Spouse, Children, etc.) 

• Export – this function is used for backing-up a certain profile.  All data from the 
phonebook will be saved, including entries, not part of smart GSM (Spouse, 
Children, etc.) if there was a previous synchronization with Pocket Outlook.  This 
also includes SMS messages and profile settings. 

• About – shows information about the program and the author 
• Exit – ends the application.  Should some changes that were made but not saved, 

a prompt would appear asking if the changes need to be saved. 
 
8.4.2 EDIT 
 

• Basic settings – opens a screen for basic settings of the profile. 
• Name interpretation – opens a screen to specify name interpretations in the 

phone. 
• Outlook settings – opens a screen to set attributes for contact synchronization 

with Pocket Outlook. 
• Clear phonebook – deletes all the contacts in the phonebook from the selected 

profile of the phone completely.  During the next synchronization all contacts 
will be downloaded once again from the phone without being deleted.  This 
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function is helpful in case you made some unwanted changes and you do not 
want these changes to appear after synchronization with the phone.  After you 
select this function, it is possible to modify some settings that were not applicable 
while the phonebook was not empty - Basic settings, Name interpretation and 
Outlook settings 

• Clear SMS messages – deletes all SMS messages and folders in the main Phone 
folder.  Messages in the smart GSM folder will remain intact.  This function is 
also helpful in case you made some unwanted changes in SMS messages and you 
do not want to synchronize them with the phone.  

• Delete – deletes the entire profile of the phone – all the contacts and SMS 
messages. If a memory was synchronized with Pocket Outlook, smart GSM will 
prompt if these contacts need to be deleted from Pocket Outlook. 
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